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   1. Accessing the Graduate School Internet Portal Service `

YONSEI UNIVERSITY GRADUATE SCHOOL  

■ Accessing the Graduate School Internet Portal Service (http://portal.yonsei.ac.kr) 
    [Login will be available on 2020. 2. 3.(Mon) after 09:30 a.m.]

1. Go to http://portal.yonsei.ac.kr. Move the cursor to "Academic Information System". Click on 
"Academic Management System (Degree Programs)".

2. Type in student ID and Password
   (Initial password is the 6 digits of birthdate in YYMMDD order)
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   2. Printing Admission Certificate
YONSEI UNIVERSITY GRADUATE SCHOOL  

■ Log in to Graduate School Internet Portal Service (http://portal.yonsei.ac.kr) 
   Click on '학적 (Student Record Management)' menu on left side of the screen -> Click on '증명' 

-> On the screen below click '출력'
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   3. Tuition Payment Guidelines `

YONSEI UNIVERSITY GRADUATE SCHOOL  

I. Tuition Payment

 1. Tuition Payment Process

What To Do Dates and Notes

Select Miscellaneous 
Fee(s) to Pay

2020. 2. 3.(Mon) 09:30 ~ 2. 4.(Tue) 16:00

↓

￭ Please mark ✓ for a miscellaneous fee(s) you wish to pay at Yonsei 
Portal Site (http://portal.yonsei.ac.kr), which is possible only during 
the period stated above. The payment will be made along with the 

tuition fee during the tuition payment period. 

Print Tuition Invoice 2020. 2. 5.(Wed) 09:30 ~ 2. 7.(Fri) 17:00

↓

￭ Go to http://portal.yonsei.ac.kr/ → Click on "Tuition and Payment" 
located on the bottom of the page → Login by typing in ID and 

password → Click "Registration" → Click "Tuition Invoice Print" → 
Click Inquiry/Registration → Click "Print"

Pay Tuition Fee (and 
Miscellaneous Fee(s))

2020. 2. 5.(Wed) 09:30 ~ 2. 7.(Fri) 17:00

￭ Failure to pay tuition and/or other fees during the above period will 
result to cancellation of admission. 

￭ Tuition can be paid via internet banking, phone banking, ATM 
transfer and teller transactions from all banks to a designated 

Woori Bank account.
￭ We recommend that you complete the payment by 16:00 on the last 

day before the bank closes in order to avoid any unexpected 
problems, such as transaction limit excess.

￭ ·Tuition Fee Table (reference) :
  http://www.yonsei.ac.kr/en_sc/admission/tuition.jsp
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 2. What is Miscellaneous Fees?

   A. Overview of Miscellaneous Fees

Item Amount(KRW)
Paid 

Semester
Related 

Association 
Contact

Graduate Student 
Association Fee 11,000 Every 

semester

Graduate School 
Student 

Association
02-2123-3671

·The association works to enhance the graduate students' welfare and 
rights. Its main activities include academic supports through special 
lectures, conferences and more, issuance of a newspaper and the design 
and distribution of student pocketbook.

http://www.gradyonsei.com/
Student Health 

Mutual-aid 
Association Fee

22,500 Every 
semester

Student Health 
Mutual-aid 
Association

Sinchon:
02-2123-3350,2

Wonju: 033-760-5430
·The association refunds a part of medical and medicine fees paid to any 
of local hospitals. Those who paid for this fee are also entitled to a 
discount at Yonsei University Health Service Center. 

https://healthma.yonsei.ac.kr/

Yonsei Coop 
Investment 5,000 1st semester

Yonsei 
University Coop 

Goods
02-2123-4038

·The Coop seeks to improve its unionists' welfare. It grants a Coop 
scholarship, provides part-time opportunities and pays dividends (if 
there's a surplus). The investment paid will be returned when the status 
as a unionist terminates.  

* Applicable only to the students in Sinchon Campus
https://www.yonseicoop.com/

   B. How to Select Miscellaneous Fees 
     Click "Registration" → Click "Print/Registration" → Click "Miscellaneous Fees Choice" → Click a 

miscellaneous fee(s) you wish to pay. 

   C. Note
     1) Selection and correction of miscellaneous fees is only possible during the designated 

period. [2020. 2. 3(Mon) 09:30 ~ 2. 4(Tue) 16:00] 
     2) During the designated period, you can correct the selection of miscellaneous fees after 

clicking 'Temporary Save'. However, no correction is possible after you click  'Print the 
Bill'. 

     3) Tuition Waivers and Scholarships do not appear on the menu of 'Miscellaneous Fees 
Choice'. Please go to the 'Browse/Registration' menu to check on them. 
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3. How to Pay Tuition

  A. Tuition fee must be transferred to an individually assigned virtual Woori Bank account in one 
installment. 

    1) Each student gets an individual virtual Woori Bank account number. When the students have 
transferred money to their virtual Woori Bank account, (even if the name of remitter is 
different from the student’s name) the student will automatically be enrolled.    

  B. Credit card payments can only be made by Woori Bank credit cards (debit cards and 
corporate cards cannot be used). 

     ※ Payments can be made at nationwide Woori Bank branches or through the Woori Bank 
website (http://card.wooribank.com). You can call the Woori Bank customer service center 
at 1588-9955 for further information.  

  C. Wire Transfer 
    1) If you are not able to pay tuition fee by any of methods stated above due to some 

conditions such as living abroad, please pay it by wire transfer.
    2) Since only one time payment is allowed, please consider the exchange rate and other 

charges for transferring the money. If the money transferred is more than the tuition fee, 
the rest will be refunded during your 1st semester. 

Bank Information
· Name of Bank(branch) : Woori Bank (Yonsei University branch)

· Recipient : Yonsei University
· Swift Code : hvbkkrsexxx

· Bank Address : 50 Yonsei-ro, Seodaemun-gu, Seoul 120-749, Korea

 4. Entrance Fee Waiver

   A. Please refer to the table below for the eligibility. The tuition amount indicated on the  invoice 
reflects the waived amount and is the fee you must submit.  

      * Go to http://portal.yonsei.ac.kr/ → Click on "Tuition and Payment" located on the  bottom 
of the page → Login by typing in ID and password (ID: Your student number; Password: 6 
digit date of birth, YYMMDD) → Click "Registration" → Click   "Print/Registration" → Click 
"Browse/Registration" → Click "Print the Bill" and check  the amount of entrance fee on the 
pop-up invoice.

   B. Please contact the graduate school office(tel. 82-2-2123-3229) before you make a payment if 
you believe the invoice reflects the wrong amount. 

Full Waiver Half Waiver
￭ For those who have been admitted as 

research program students at Yonsei 
University Graduate School(YUGS) or who 
have achieved Master's degree from YUGS 

AND 
advance to higher degree program at YUGS.

￭· For those who have graduated from or 
are enrolled at YUGS and enter into a 

different department of YUGS.

·￭ For those who have completed research 
program at or achieved Master's or 

Doctoral degree from any of professional 
and/or specialized graduate schools at 
Yonsei University and enter any one of 

department of YUGS   
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5. Verification of Tuition Payment

  To verify your tuition payment, go to http://portal.yonsei.ac.kr/ → Click on "Tuition and  
Payment" located on the bottom of the page → Click "Registration" → Click "Print/Registration" → 
Click "Print Payment Verification"

6. Entering Personal Bank Information

  A. Please register your personal bank account number to Yonsei Portal website. Your bank  
information is necessary for granting scholarships, returning the tuition balance and more.

  B. In case the name registered at Portal site and the name of account holder are not exactly the 
same, you may not be able to enter your bank account number successfully. In that case, 
please send a copy of your bank book and your student ID card to the Graduate School office 
(chan0214@yonsei.ac.kr). You can also visit the graduate school office (Stimson Hall 2F, 
Building No. 502).

  C. How to Register : Go to http://portal.yonsei.ac.kr/ → Click on "Tuition and Payment"  located 
on the bottom of the page → Log in by typing in ID and password (ID: Your  student number, 
Password: 6 digit date of birth, YYMMDD)→ Click "Student Record" → Click "Information" → 
Click "Personal Data" → Find 계좌정보 and Click "Modify" → Input your bank information → 
Click “저장” (Save).
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Graduate School Tuition Fee Payment Guideline

1.  Go to portal.yonsei.ac.kr  → Click on "Tuition and Payment" located on the left hand of the 
page

2. Log In : Typing in ID and password (ID: Your student number, Password: 6 digits of date of 
birth, YYMMDD) 
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3. Select Miscellaneous Fees : Click "Registration" → Click "Print/Registration" → Click 
"Miscellaneous Fees Choice" → Click a miscellaneous fee(s) you wish to pay → Click 
"Miscellaneous Fee Confirm" 

4. Printing the Bill  : Click "Registration" → Click "Print/Registration" → Click "Print the bill"
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5. Tuition Fee Payment: Tuition fee shown in the individually assigned virtual Woori Bank 
account must be paid in one installment. 

   - Each student is given an individual Virtual Woori Bank account: When the students remit money to their 
virtual Woori Bank account, (even if the name of remitter is different from the relevant student’s name) 
the student will automatically be enrolled.  

6. Verification of Tuition Payment : Click "Registration" → Click "Print/Registration" → Click 
"Print Payment Verification"
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   4. Guidance for Student ID Card Issuance
YONSEI UNIVERSITY GRADUATE SCHOOL  

1. The student ID card is a multi-purpose identification card for Yonsei University 
   students. It is issued in collaboration with Woori Bank. It gives you access to university 
   facilities such as libraries, sports facilities, computer rooms, etc. It also allows you to
   show electronically your attendance for classes. It can be used as a check card to pay
   at stationery stores, bookstores, and restaurants after opening a bank account at a 
   campus Woori bank. Discounted price may be available at some stores on and off the
   campus if you show the card when purchasing. It can be also utilized as prepaid public
   transportation card in Korea after the cash charge in the campus ATMs. Please be 
   aware that you can not get a refund for the amount left charged to your electronic 
   currency if your ID card is lost or stolen.   

2. Eligibility: 2020 Spring Semester enrolled international students who consent to a 
   personal information collection, utilization, and processing entrustment to a trustee 

3. Application Period

4. How to find your student number

   Visit the Graduate School Website (http://graduate.yonsei.ac.kr/graduate_en/index.do) on     
   Friday, December 13, 2019 after 5 pm. Check the Final Result of Spring 2020 Admissions  
   menu and type in your examinee’s number and your D.O.B. in YYMMDD order. 

5. How to Apply 

   Visit Yonsei Portal Service (https://portal.yonsei.ac.kr/main/indexe.jsp) -> Log in with 
   your student ID number and PW (intial PW : D.O.B. in YYMMDD order) -> Academic 
   Information System -> Issue Student ID -> Apply for an ID card -> Agree with personal 
   info. collection, utilization, and processing entrustment to a trustee -> Check 
   applicant’s information -> 신청(Apply)
   ※ A photo file should be a JPG format with no more than 200KB. 
     
6. ID Pick-Up Period and Location (Your designated campus bank)

    ￭ Period: March 16 (Mon), 2020 ~ 18 (Wed) from 9 am to 8 pm (For those who applied 
by Friday, February 28, 2020.

    ￭ Locations of Woori Bank (WB):  
      - Sinchon Campus: WB in the Student Union Building (Campus Map Bldg. No. 207) 
      - Songdo Campus: WB in the Songdo Dormitory B (Campus Map Bldg. No. 306) 
      - Wonju Campus: WB in the Yonsei Plaza (Campus Map Bldg. No. 12) 
    ※ Please visit the Bank with your passport or alien registration card to receive the ID 

Student Date Note

 International
   Students

 Feb. 20 (Thu), 2020 at 10 am ~
If you want to receive it during 
the first three pick-up days, 
please be sure to apply by Friday, 
February 28 at 11:59 pm. 

Before the application period, 
online applications cannot be made.
After the application period, you 
may receive it around late-March. 
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card. ※ After the above period, you can pick it up during the bank opening hours 
from 9 am to 4 pm on weekdays.

7. Student ID Card with Check Card Function 

   If you want to use your Yonsei student ID card for cash deposit/withdrawal in ATMs,
   please take your alien registration card and a certificate of attendance to open 
   a bank account to Woori bank on the campus. Please be advised that a certificate of 
   attendance is available free of charge on the Online Transcripts & Certificates menu at 
   Yonsei Portal Service or at the University Service Center with payment from March 1. 
   Foreign registration card may take a maximum of one month to receive from Korea 
   Immigration Service. 

8. Student ID Card Reissuance

   Visit Yonsei Portal Service (https://portal.yonsei.ac.kr/main/indexe.jsp) -> Log in with 
   your student ID number and PW -> Academic Information System -> Issue Student ID 
   -> Press Lost/Damaged/Expired Card Mgmt. button -> Lost/Damaged/Expired Card -> 
   Registration -> Register -> ID Card Mgmt. -> Apply for an ID card -> Follow the 
   application steps as above. It takes usually one week to obtain the card at the campus 
   bank without charge. 
    - How to Report a Lost/damaged ID Card : Register at Yonsei Portal Service to prevent the 
      lost/damaged ID card from being used again. Call the Woori bank customer service center 

immediately at 1588-9955 to stop its use if it is connected with your Woori Bank Account.

9. Cancellation of Lost/Damaged/Expired ID Card Report 

   Yonsei Portal Service -> Log in -> Academic Information System -> Issue Student ID -> 
   Present Condition and Cancellation of the Lost/Damaged/Expired Card -> Report 
   Cancellation.
 
10. Office Hours: Mon-Fri 9 am ~ 5:20 pm

11. Inquiries

   • University Service Center on Student ID Card: +822-2123-3200 (from overseas),
     2123-3200 (in Seoul)
   • Immigration Contact Center on Alien Registration Card: +82-1345 or +822-6908-1345 
     (from overseas), 1345 (in Seoul) 
   • Banking Service for international students at Woori Bank: +822-1599-2288 (from 
     overseas), 02-1599-2288 (in Seoul)
  . • Student ID Distribution at Sinchon Campus: Woori Bank: +822-313-3198 Ext. 313 or 
     321 (from overseas), 02-313-3198 Ext. 313 or 321 (in Seoul)
   .• Student ID Distribution at Songdo Campus: Woori Bank: +8232-822-6321 (from 
     overseas), 032-822-6321 (in Seoul)
   • Student ID Distribution at Wonju Campus: Woori Bank: +8233-760-5159 (from 
     overseas), 033-760-5159 (in Seoul)

UNIVERSITY SERVICE CENTER
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￭ You are required to register for courses via Yonsei portal (http://portal.yonsei.ac.kr) during the 
course registration period. This is not for the current semester, but for the upcoming semester.

￭ Under Article 21, Section 2 (Academic Probation) of the University Statutes and Regulations, 
students shall be placed on academic probation if their GPA falls below 2.0, and if they are on 
probation for two semesters in total, they will be academically dismissed. Students may be 
readmitted after dismissal, however, if they fail to meet the GPA requirement once again, they will 
not be able to apply for readmission. Please bear this in mind and enroll for your courses after 
full consideration. 

 
※ International students (who do not hold a Korean citizenship) will not be able to register for 

courses until they upload their Certificate of Insurance on Yonsei Portal. 
   (http://portal.yonsei.ac.kr, tel: 2123-3228 ) Academic Information System → Academic 

Management System → Student Record → Information → Insurance (jpg format only) (Please 
refer to page 19 for detailed information)

I. IMPORTANT INFORMATION

1. Registration Period for New or Current Students (Graduate and Supplementary Courses) 

     - 2020. 2. 17(Mon) - 2. 21(Fri) 
       * Online registration: 10:00 - 23:59.  

2. Add/Drop Period (Graduate and Supplementary Courses)

     - 2020. 3. 19(Thu) - 3. 23(Mon)
       * Online registration: 3. 19(Thu) - 3. 20(Fri) 10:00 - 23:59.
                             3. 23(Mon) 10:00 – 18:00

3. Course Selection

    A. Course Catalog and Syllabus
You can browse our course catalog and view syllabi on Yonsei Portal.

        http://portal.yonsei.ac.kr
        ￭ Main Portal Service → Course Catalog and Syllabus: Undergraduate & Graduate
        ￭ Academic Information System → Academic Management System → Course → Course 

Catalog 
          1) Changes to Courses: Changes made to the timetable during the registration period will 

be marked in blue. 
          2) Syllabus: Click on the purple arrow/note icon next to the course title to read the 

course syllabus.
    B. Credits
      1) How to check the number of credits you have earned 
        ￭ Go to Yonsei Portal (http://portal.yonsei.ac.kr) → Academic Information System → 

   5. Course Registration 
YONSEI UNIVERSITY GRADUATE SCHOOL  
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Academic Management System → Login → Student Record → Information → Grading 
Browse → Below the field heading “PSD (PASSED)“ is the total number of credits you have 
earned.

Degree
Minimum Number of Credits 

Required for Graduation
Minimum GPA Required 

for Graduation
Note 

Master's* 30 credits
3.0/4.3 (B0) or higher 

Minimum credit 
requirement for graduation 
may vary by departments.

Doctoral 30 credits
Joint 54 credits

       * : including students who have withdrawn from Joint Degree programs

        ※ Even though you register to audit a Major or credit course, it will count towards the 
number of credits you are allowed to take per semester. Those who are taking an 
additional semester will be charged for the extra credits. (For detailed information, please 
refer to “4. Important Notes”) 

        ※ Audited or supplementary courses with credits do NOT count towards the credit 
requirement for graduation.

      2) Directed Research Course (Non-credit) 
Under Article 2 of the Graduate School Thesis Regulations and Policies (submission 
requirements), students whose proposal has been accepted (or will be accepted in the 
upcoming semester) must enroll in Directed Research courses. 

     

Degree Regulations Course Title

Master's* After your proposal is approved, you should register for 
"Directed Research 1" course at least for one semester.

"Directed 
Research 1"

Doctoral/ 
Joint 

After your proposal is approved, you should register for 
"Directed Research 2" course at least for two semesters.

"Directed 
Research 2"

* : including students who have withdrawn from Joint Degree programs

    C. Retaking a course 
     1) Courses with the identical code and/or title are considered to be the same; if you take the 

same course twice, it will count as a “retake”. In this case, only one of them shall be 
credited. When you register for those courses, a notice will be given in a pop-up window.

        ※ You are allowed to retake a course once if you wish to achieve a better grade.   
     2) The above rule does not apply:
    ￭ if you register to “audit“ the course (on a Pass/Not pass basis)
         ￭ if the course is a "supplementary" course (Undergraduate) whose title is the same as that 

of Graduate School
 ￭ if different departments offer courses with the same title

     3) PhD students: if you register for the same course you took while doing your Master’s at 
Yonsei University Graduate School, it will NOT be considered as a retake. However, it 
might not fulfill requirements toward graduation, so please check with your department 
first.  
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4. Important Notes

    A. Please make sure to select the right option for the type of course (eg. Major, Audit, 
Research, Supplementary).

    B. Graduate students (Degree program) can register for a maximum of 12 credits per semester 
(including supplementary courses). 

      ￭ Non-degree students may take up to 6 credits per semester. They need to select the 
"Research" option for graduate courses and the "Audit" option for undergraduate courses.  

      ￭ Students MUST check the time schedules for Intensive or Field Training courses. 
Soon-to-be graduates and KGSP (Korean Government Scholarship Program) students are 
allowed to enroll for those courses only if they are required to graduate.   

      ￭ Students registering for the online course in Research Ethics must log into Yonsei Portal 
(http://yscec.yonsei.ac.kr) to take the course. It opens on the first day of the semester and 
closes at 23:50 of the day (weekday) before the final exam period begins. 

    C. Please consult with your advisor or the head of the department before enrolling in courses. 
    D. Registration fo r Supplementary Courses
       1) Requirements for supplementary courses may vary among the departments; if you gained 

your previous degree in a different field of study than your current one, please contact 
your department before registration. The maximum number of credits you can take for 
supplementary courses is 12 in total.   

       2) You can register for supplementary courses via Yonsei Portal.
       3) You can choose to take those courses either on a supplementary (Graded) or an audit 

basis (Passed/Not Passed). They do not count towards the cumulative GPA or the credit 
requirement for graduation.           

    E. Registration for "Directed Research" Course
       1) Under the regulations set by the Graduate School Management Committee, since Spring 

semester 2003, Directed Research Course (I for Master’s candidates or those who have 
withdrawn from the Joint Degree program; II for Doctoral or Joint Degree candidates) has 
been automatically enrolled for students who are expected to graduate (Master’s and 
Doctoral candidates in their 4th or later semester; Joint Degree candidates in their 6th or 
later semester), Please check whether you are properly enrolled in the course during the 
registration period, and if your thesis proposal has not yet been accepted (or will not be 
in the following semester), you can delete it, 
※ If you meet your degree requirements earlier than your final semester, please submit 
the “Directed Research Registration Request Form” to the Graduate School Office during 
the course registration period in your third semester of Master’s* program, second 
semester of Doctoral program, fifth semester of Joint Degree program, respectively. 

         * : including students who have withdrawn from Joint Degree programs 

         (You need to contact your department to get the form and ask about the degree 
requirements.)          

       2) 12% of your tuition will be charged for an additional semester, provided that you only 
take the Directed Research course.  

    F. Your tuition fee for an extra semester (5th or later semester of Master's/Doctoral program; 
7th or later semester of Joint Program) will be charged according to the number of credits 
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registered for. Please print your tuition invoice during the Additional Registration period.
       1) Tuition fees  
           ① 0 credit: 12% of tuition
           ② 1-3 credits: 1/3 of tuition
           ③ 4-6 credits: 2/3 of tuition
           ④ 7 credits or more: full tuition
    G. You are required to take at least one course. If the course is canceled or you failed to get 

permission to take a supplementary course, please consult your department. Important 
notice about the course registration will be sent via email or text messages, so make sure to 
update your personal information on our portal (http://portal.yonsei.ac.kr) if there is any 
change. 

 ￭ Academic Information System → Academic Management System → Login → Student Record 
→ Information → Personal Data → Modify

    H. Credit Exchange Program (Cross-Registration) 
       1) You can enroll for courses in other specialized graduate schools of Yonsei University. 

You may take up to 6 credits per semester and 15 credits in total. Please note that the 
courses may NOT be audited. 

       2) Yonsei University Graduate School also has cross-registration agreements with other 
graduate schools in Korea. You may enroll in their courses as well; the courses may not 
be audited and credits will be awarded in accordance with the agreements with the host 
universities. 

       3) Under the agreement between three graduate schools located in Sinchon area, you can 
register for courses offered by Ewha Womans University or Sogang University via Yonsei 
Portal during the course registration period.  

          ￭ Choose “Ewha Womans university” or “Sogang University” in the list of departments. 
          ￭ The information about timetables and lecture rooms can be found on their websites.
            ① Ewha Womans University → Study Guideline→ Timetable/Syllabus → Graduate school
             (http://eureka.ewha.ac.kr/eureka/hs/sg/openHssg504024q.do?popupYn=Y&englishYn=Y)
            ② Sogang University → Graduate School → Information of Courses
             (http://sis109.sogang.ac.kr/sap/bc/webdynpro/sap/zcmw9016?sap-language=EN)
       ※ For the information about course registration in other graduate schools in Korea, please 

refer to the notice of our website (http://graduate.yonsei.ac.kr). If you wish to take courses 
at one of the universities, please submit the application form to the Graduate School Office 
before the deadline given in the notice. 

II. ONLINE COURSE REGISTRATION

 1. How to Register for Graduate Courses

   A. Go to Yonsei Portal (http://portal.yonsei.ac.kr) and click "Graduate Course Enrollment" on the 
Main Portal Service menu. (This service will be available from 10:00 am on the first day of 
the course registration period.)

   B. Login with your student ID and password (Default password: your date of birth in YYMMDD 
order). 

   C. Read the instructions carefully before you start. 
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   D. Click on "Course Enrollment". The next page will show your department, major, and available 
courses. You can register for a course by clicking on its code which is in blue. The list of 
enrolled courses will appear at the bottom of the page. To cancel your registration, you need 
to click on the code on the list. 

 2. How to Register for Supplementary Courses 

     (Refer to page 18-19 for detailed guidelines)
    A. Go to http://portal.yonsei.ac.kr → "Academic Information System" →"Academic Management 

System". 
    B. Login with your student ID and password (Default password: your date of birth in YYMMDD 

order). 
    C. Click “Course” on the left menu → “Undergraduate Supplementary Course” and read the 

notice carefully. 
    D. If you click on “Undergraduate Course Registration”, you can browse undergraduate courses. 

Select the program category, college and major first and then click “Browse” to check the 
list of courses available. You can request permission to take a course by clicking the note 
icon.   

    E. In order to view the status of your request, click “Result” on the left menu. 
    F. If you want to cancel your request, just click “X” button on the list of your supplementary 

courses. If you want to drop the course after the final approval is granted, you need to go 
to “Course” → “Course Enrollment” menu (graduate course) and click the blue course code 
on the list of your registered courses.  

    G. To see the final list of your supplementary courses (approved), go to “Course Enrollment” → 
Enrollment Status or “Graduate Course Enrollment”.

Ⅲ. IMPORTANT DATES 

    1. Course Withdrawal: TBA  
      ※ Withdrawn courses are marked W in the Transcript. 
      ※ Tuition is not refundable even in the case of course withdrawal
    2. Course Evaluation, Survey for Improvement of Research Environment &  

Graduate Programs: TBA

     3. Grade Confirmation & Request for Grade Change: TBA
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Supplementary Course Registration Guidelines 

1. General Information

  A. When you register for supplementary courses, you must comply with the regulations of 
your department. 

  B. No more than 12 credits, including supplementary courses, may be taken per semester.  
  C. The maximum number of credits allowed for supplementary courses is 12.     
  D. You should choose to take supplementary courses either on a supplementary (Graded; 

letter grade such as A+, B0 on the transcript) or an audit basis (Passed/Not Passed; P/NP 
on the transcript).

  E. Supplementary courses do not count towards the cumulative GPA or the credit requirement 
for graduation.   

2. Registration Period: Course Registration and Add/Drop Period 

  * Wonju Campus students can also enroll for courses via Yonsei Portal System

3. How to Register for Supplementary Courses

  A. Go to Yonsei Portal (http://portal.yonsei.ac.kr). Place the cursor on "Academic Information 
System" to click on "Academic Management System". 

  B. Login with your student ID and password (Default password: your date of birth in YYMMDD 
order).  

  C. Click “Course” on the left menu → “Undergraduate Supplementary Course” and read the 
notice carefully. 

  D. If you go to “Course Enrollment”, you can browse undergraduate courses. Select the 
program category, college and major first and then click “Browse” to check the list of 
courses available

* Please note that to register for Graduate courses you must go to “Graduate Course 
Enrollment” on the Main Portal Service menu. 
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 E. After selecting the course you wish to take and click the note icon . It will be added to 

the list of your enrolled courses at the bottom of the page. If you want to drop the course, 
click the icon   on the list again. 

 F. If you want to cancel your request, just click “X” button on the list of requested courses. If 
you want to drop the course after the final approval is granted, you need to go to the 
“Course Enrollment” menu and click the course code on the list of your registered courses.  

 G. Your request might not be approved either by your department or the Graduate School 
office for some reasons (e.g. regulations of the department, credit limit etc), so please make 
sure to check the status of your request – whether it is fully accepted or not - on Yonsei 
Portal. 

Approval Status Where to Drop Notes

 Request just submitted Undergraduate Supplementary 
Courses → Course Enrollment

You may not be able to drop 
courses while your request is 
pending approval
(To check the status of your 
request, click “Result” on the 
left menu)

Approved by the 
Department

Undergraduate Supplementary 
Courses → Course Enrollment

Approved by the 
Graduate School Office

Course → Course Enrollment → 
Enrollment Status
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   6. Library Guide
YONSEI UNIVERSITY GRADUATE SCHOOL  

1. Library Webpage: http://library.yonsei.ac.kr
For more details about library services such as Library Catalog, Research Guide, Purchase Request,
Interlibrary Loan, and Document Delivery Service, please refer to the library webpage above.

2. Library Hours

Type Name During Semester During Vacation
Mon. – Fri. Sat. Mon. – Fri. Sat.

Central 
Library

24 hour Study Room(1F) Opens 24 hours

Privileges Office(1F) 09:00-17:00 - 09:00-17:00 -
Humanities Collections: Books(2F)

09:00-21:00 09:00-15:00 09:00-20:00 09:00-15:00
Social Sciences & History 

Collections: Books(3F)
Science & Technology Collections: 

Books(4F)
Korean Classics Collection(5F) 09:00-17:00 - 09:00-17:00 -

Graduate Study Room(5F) 06:00-23:00
Study Room 1(6F) Opens 24 hours 06:00-23:00
Study Room 2(6F) 06:00-23:00 -

Yonsei- 
Samsung 
Library

Y-Valley(1F) 08:00-23:00
Makerspace(1F) 09:00-18:00 - 09:00-18:00 -

Information Commons(2F)

09:00-21:00 09:00-15:00 09:00-20:00 09:00-15:00Multimedia Center(3F)
Research Commons: 

Journals, References(5F)
Makerspace(1F) 09:00-18:00 - 09:00-18:00 -

Grand Study Room(4F) 08:00-23:00
Cafe(8F) 08:50-20:00 09:00-16:00 09:00-17:00 -

Branch 
Libraries

Law Library
(Yonsei-Samsung Library 6F) 09:00-21:00 09:00-15:00 09:00-20:00 09:00-15:00

Music Library
(College of Music, New Bldg. 2F) 09:00-18:00 - 09:00-18:00 -

Underwood Memorial Library
(International Campus) 08:30-24:00 09:00-18:00 09:00-18:00 -

 ※ For more details about library hours, please refer to the library webpage.

3. Temporary access before Yonsei student ID card issuance

New students can enter the Library with presentation of a tuition payment receipt and an ID 
card at the information desks of the Library. 
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   7. Yonsei Health Mutual-aid Association
YONSEI UNIVERSITY GRADUATE SCHOOL  

1. Website : https://healthma.yonsei.ac.kr

2. Sinchon Office : Student Center Rm. 206 (02-2123-3350, 3352)
3. Office Hour during Regular Semester : Mon-Fri 9:00-17:00 (Lunch 12:00-13:00)
4. Office Hour during Summer/Winter Breaks : Mon-Fri 9:00-15:00 (Lunch 12:00-13:00) 
5. The Yonsei Health Mutual-Aid Association Qualification for Membership: 

  ￭ Membership is exclusive to Yonsei University Undergraduate and Graduate students.
   (Not applicable to family members)

Classification Availability of Deduction
Available Period of 
Deduction & Limit 

Period Limit

    Current Students
Available if signed-up as members 

of the Mutual-aid through 
registration or optional payment

Relevant
semester 
(Receipts 
should be 
submitted 

by the end 
of the next 
semester)

Registration
: 

Spring
Semester
Mar 1st~ 
Mar 31st

Fall
Semester
Sep 1st~
Sep 30th

1million KRW
including
outpatient
treatment 

and 
hospitalization

Students 
on 

Leave
of

Absence
 

Unregistered student 
on leave of absence Available if signed-up as members 

of the Mutual-aid through 
registration

Students on leave
of absence with full

refund of tuition
Students  on a 

leave of absence 
within 90 days  

from the start of 
semester

Available if signed-up as members 
of the Mutual-aid through 

registration or optional payment

Outbound
Exchange Students

Available during relevant semesters 
as exchange students if signed-up 

as members of the Mutual-aid 
through registration
Registration period

1st semester: March 1 ~March 31
2nd semester: September 1 

~September 30

Undergraduate students
of Wonju Campus

taking an extra semester 
(students only

attending chapel)

Available during relevant extra 
semesters if signed-up as members 

of the Mutual-aid through 
registration

Registration period
1st semester: March 1 ~March 30

2nd semester: September 1 
~September 30

6. Semesters: Spring Semester: March 1 - end of August
                   Fall Semester: September 1 - end of February (following year)
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7. Becoming a Member

  1) Optional Payment
     Membership for Mutual Aid Association has become optional since 2013 Spring semester. You 

become a member by paying KRW 22,500/per semester. Students who did not pay the optional 
fee can also become a member association by separate means. 

  2) Membership
  ￭ Sinchon Campus ․ International Campus
   1) Undergraduate, Graduate students (including professional and specialized school) 
      (For students who did not pay optional fee during registration period)
   2) Students on leave of absence  
   3) Exchange students (Students participating exchange program conducted by Yonsei University's 

Office of International Affairs : Exchange, Visiting, GIP, SA) - Only Outbound Exchange 
Student are Allowed ; Inbound Exchange Student are NOT Allowed.

  ￭ Wonju Campus
   1) Undergraduate, Graduate students 
      (For students who did not pay optional fee during registration period)
   2) Students on leave of absence  
   3) Exchange students (Students participating exchange program conducted by Yonsei University's 

Office of International Affairs : Exchange, Visiting, GIP, SA) - Only Outbound Exchange 
Student are Allowed ; Inbound Exchange Student are NOT Allowed.

   4) Undergraduate students taking NP classes 

8. Sign-up Period : Sign-up will not be allowed after this period
  ￭ Spring Semester: March 1 ~ March 31 (During Office Hour)  
  ￭ Fall Semester: September 1 - September 30 (During Office Hour)

9. Location and Requirements : Mutual Aid Association (walk-in sign-up / Account transfer)
  ￭ Student ID, Membership fee (KRW 22,500, Only cash allowed)
  ￭ It is possible to sign up for other people, so if you are signing up for other students, please 

bring his/her student ID card and membership fee.
  ￭ Account information will be noticed during sign-up period
  ￭ In case of registration after the sign-up period, membership will activate from the day after 

registration till the end of the semester. 

10. Students on Leave of Absence Application

    Due to change as optional payment, when tuition fee is refunded membership fee will not be 
refunded (unless the student has applied for leave of absences before the final enrollment 
date) 

  ※  Students on leave of absence 
      As the Mutual-aid Association fee became optional, it cannot be refunded for students on 

leave of absence. (However, students who took leave of absence before the final registration 
period can get full refund.)

  ※ For detailed information on tuition and Mutual-aid Association fee, please refer to the 
academic schedule. 



- 23 -

 11. Materials to Prepare and Method of Deductions Application

  ① Treatment (medical expenses) Original Receipt: Payment (Insurance), Record of the division of 
Non-Payment (No Insurance) format, Treatment Date and Treatment Dept. (Copies will not be 
accepted) 

  ② Student ID Card of Yonsei University (or Statement of Enrollment)
  ③ Woori Bank Account Number of the Student (No need to copy account booklet – just record 

the account number)

Classification Campus Place Contact

Register
by

visiting

Sinchon
International Sinchon Campus Student Center Rm. 206 02-2123-3350,2

Wonju

Wonju Campus Student Center Rm. 242
(Receiving Box prepared in front of the 

Student Association Office in Wonju 
Medical School)

033-760-2682

Register
by Mail

Sinchon
International

Mutual Benefit Association for Student 
Health,

Rm. 206, Student Center of Yonsei 
University,  Shinchon-dong, 

Seodaemun-ku, Seoul  

 

Wonju

Mutual Benefit Association for Student 
Health,

Rm. 242, Student Center of Yonsei 
University,  Yonseidae-gil 1 Wonju 

Kangwon Province

 

   * When the three items above are prepared, registration by proxy is possible / Registration is 
possible regardless of affiliation at Sinchon, Wonju, or the International Campus.

   * Students in International Campus can register by mail or receipt container.
     Receipt container located in 종합관 1층, 송도학사 D동 1층

12. Available Hospitals / Range of Available Deduction

   ￭ Available Hospitals : Any hospital located in Korea (Oversea Hospitals are excluded) 
   ￭ Range of Available Deductions : Limited to insurance payment of treatment expenses
                                    (Non-Insured Treatment is excluded)

        Subject
Treatment   

Mutual Benefit Association

1st Treatment Institution
(Private Clinic) Student Payment’s 50%

2nd Treatment Institution
(Hospital level) Student Payment’s 40%

3rd Treatment Institution
(General Hospital) Student Payment’s 30%
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 ※ Non-Insured Treatment: National Health Insurance Corporation designated illnesses, delivery, 
non-life-threatening injuries or those not encumbering one’s job or daily life as items not 
covered by the standard insurance plan to limit financial issues and to maintain fairness of 
social insurance payments. Typical examples of non-insured medical treatment are 
orthodontia, plastic surgery for beauty treatment, surgery for eyesight correction, diet and 
skin care. For details on insurance payment/non-payment, please inquire at the hospital where 
you receive the treatment.

  ※ The deduction shall not exceed the actual insurance payment of one’s share. 

13. Contact to Yonsei Health Mutual-aid Association

    - Homepage: https://healthma.yonsei.ac.kr

    - Sinchon Office: Student Center Rm. 206/ 02-2123-3350,3352
    - Wonju Office: Student Center Rm. 212-1/ 033-760-5430
   * Please contact the relevant office for other inquiries.

3rd Treatment Institution
(Special General Hospital) Student Payment’s 20%

School Health Center

90%
(In the case you have paid both 

Student Health Mutual-aid 
Association Fee AND Health 

Expenses)
        Subject
Hospitalization

Mutual Benefit Association

Every Institution Student Payment’s 30%



- 25 -

1. Eligibility & Selection Method 

 A. Eligibility 

  ◼ 2020-1st semester enrolled and returnee Undergraduate Students and                      

Graduates(regular and professional) Students of Shinchon Campus. (Qualification 1)          

GPA previous semester's GPA 1.7/4.3(Undergraduate) or 2.0/4.3(Graduate) or above)

  ◼ 2020-1st Freshmen of General and Specialized Graduate Schools of Shinchon Campus

  ◼ Locals (exclusive of Seoul), Oversea Koreans (based on the parents’ residence), 

     and Foreign Students

 B. Selection Methods: Online Apply and Computerized Random Selection

 C. Note

   ※ Muak #4 Remodeling Schedules  

    -Period: 24th of August, 2020~ 31st of January, 2021

    -Please be aware that the Foreigners’ Building at Muak #4 also will be renovated.          

Therefore, ALL the Muak #4 residents need to check-out by 22nd of August, 2020          

due to the construction. Please apply different dormitory for the 2020-2nd semester.

   1) Students of Law Department and Law Schools can ONLY apply to the Beophyeon          

House.

   2) Medical Related Students

     a. Students of Department of Medicine can ONLY apply to Chejung House

       (Tel: 02-2228-2700)

     b. Undergraduate and Graduate students of College of Dentistry and College of            

Nursing can ONLY apply to Muak #3

   3) Students belonging to the Future Campus are NOT allowed to apply for dormitories       

at Sinchon Campus.

   4) Double applications between Shinchon and International Campus dormitories are NOT      

allowed.

   5) If you leave school during the semester, MUST check-out the dormitory 

2. Dormitory Fee & Facilities

 8. Application Guidelines for Muak Dormitory

YONSEI UNIVERSITY GRADUATE SCHOOL  

Dormitory Type Object
Dormitory 

Fee
Size(평)

Shower 

room & 

Bathroom

Facilities

Muak #1 Double Undergraduate 794,390won 4.09 Shared Lounge, Gym, Study room, 
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3. How to Register

 A. Period : Tue, 7th of  Jan, 2020 10:00 – Wed, 8th of  Jan, 2020 23:00

 B. How : Fill out the on-line form (pop-up) on Housing office web site.  

           (http://web.yonsei.ac.kr/housing) 

4. Essential Submit Document

  ※ If you are a foreigner no need to prove address of your parents to apply Shinchon       

Campus Dormitories.

5. Result Update : Fri, 17th of January, 2020 19:00  

                    Housing Office Website (http:// web.yonsei.ac.kr/housing)

  Payment period : Mon, 20th of  Jan, 2020 10:00 – Tue, 21st  of  Jan, 2020

6. Health Inspection

※ The available period of health certificate : within 2 month from a date of issue(issued 

AFTER 28th of December, 2019).

The students selected as the residents must have health inspection (pectoral X gland) and 

then submit the health diagnosis form on the day of their check-in. If you avoid the health 

inspection or are found to be ineligible for community life, we will cancel your housing 

admission. Failure to submit the health diagnosis form (흉부X선 검사) on the check-in day 

will result in demerits on your record.

(Male)

Laundry room, Computer 

room,  Seminar room,  

Convenience store, and  

ATM

Muak #2 Double
Undergraduate 

(Female),
Graduate (Female)

833,940won 4.09 Shared

Lounge, Main Dormitory 

Food Court, Store, Gym, 

Study room, Laundry 

room, Computer room, 

Prayer room

Muak #3 Double

Undergraduate and 
Graduate of

Dental and Nursing 
College 

(Male, Female)

857,670won 4.27 Shared

Community room, Laundry 

room, Study room, 

Computer zone, Gym, 

Chapel & Prayer room, 

Self kitchen, Convenience 

store, Self-Cafe
Muak #4 Foreigners’ 
Building(B-Wing 2~5F)

*Muak #4 is 
scheduled to be 

remodeled 

Single Foreigners and 
Oversea Koreans
-Undergraduate,

Graduate
(Male, Female)

2,005,750
won

6.4
Inside the 

room
Community room, Laundry 

room, Study room, 

Computer room, Gym, 

Yoga room, Self-kitchen
Double 1,337,920

won
8.6

Inside the 
room

Beophyun House Double

Law School
General, Specialized 

Graduate School
(Male, Female)

1,337,920
won

6.9
Inside the 

room

Convenience store, Cafe, 

Restaurant, Study room, 

Gym, Lounge, Laundry 

room, Self-kitchen, ATM
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7. Check-in and Check-out Day 

  A. Check-in date- Fri, 28th of February, 2020 (check-in 10:00 ~ 18:00)

  B. Check-out date- Sat, 20th of June, 2020 (check-out before 12:00)

8. Contact Information 

  A. Muak and Woojungwon Dormitories: 02)2123-8419, 3602, 3622

  B. Beophyeon House: 02)2123-3693

  C. Email : muakdorm@yonsei.ac.kr

※ The schedules mentioned above might be changed due to the change of university’s 

academic calendar.

Housing Office



- 28 -

D-2 유학생 비자(석사: D-2-3, 박사: D-2-4)를 발급할 예정인 학생들은 표준입학허가서(합격증과는 다
른 서류입니다. p.3 참조)를 신청해주시기 바랍니다. 다른 비자(A-1, A-3, D-1, D-5, D-9, E-1, E-7, 
F-1, F-6, H-2, 재외동포 비자 등)를 소지하여 입국 및 국내 체류에 문제가 없는 경우, 표준입학허가
서를 별도로 신청하실 필요 없습니다.

※ 유의 사항

  1. 국내에서 학부를 졸업하고 대학원에 진학하는 경우, 기존 비자는 만료됩니다. 

     연세대학교 일반대학원에서 발급한 표준입학허가서를 지참하여 신규 비자를 취득하시기 바랍니다. 

  2. 유학생 비자는 학적변동(휴학, 졸업, 제적 등) 발생 시 비자만료일과 상관없이 학적변동일 기준으로

     만료일자가 수정됩니다. 유학생은 학적변동일로부터 30 일 이내 출국해야합니다.  

“Certificate of Admission”(which is different from the Certificate of Acceptance that can be 
printed out on the Yonsei Portal) is issued only for those of students who will apply for a 
D-2 visa (D-2-3: Master’s, D-2-4: Ph.D). If you hold any other visa(A-1, A-3, D-1, D-5, 
D-9, E-1, E-7, F-1, F-6, H-2, etc.) and can legally stay in Korea, you don’t need to apply 
for D-2.

※ Attention 
1. If you just have finished undergraduate program in Korea and are going to enter our 
school, your old D-2 visa is expired from the date of graduation. Please request for the 
“Certificate of Admission” and obtain a new D-2 visa.  
2. In case of any change in the student’s status(taking a leave of absence, graduation, 
expulsion due to withdrawal or unregistered status, etc.), D-2 visa gets to be expired. You 
must leave the country within 30 days from the date of change in the student’s status. 

비자 종류에 대한 자세한 사항은 링크를 통해 확인 하십시오.
https://www.visa.go.kr/openPage.do?MENU_ID=10102

 Please refer to the following web site for information about the types of Korean visa    
 https://www.visa.go.kr/openPage.do?MENU_ID=10102

 9. Visa Issuance for International Students

YONSEI UNIVERSITY GRADUATE SCHOOL  



- 29 -

D-2 비자를 신청하실 분들은 2019 년 12 월 31 일(화)까지 

재정증빙서류, 여권사본, 사진파일(3.5cmX4.5cm, jpg)을 
ysgrad@yonsei.ac.kr (신촌캠퍼스 합격생) 
acqwj@yonsei.ac.kr (원주캠퍼스 합격생)
yunjlee@yonsei.ac.kr (원주캠퍼스 의과대학 합격생)
으로 보내주시기 바랍니다. 표준입학허가서는 메일로 발송해드립니다. 

If you are going to apply for a D-2 visa, please submit copy of proof of funds, passport, 

and passport-size photo (3.5cm x 4.5cm) in jpg format, by December 31 (Tue) 2019 to the 

following contact address.

ysgrad@yonsei.ac.kr (Seoul Campus) 
acqwj@yonsei.ac.kr (Wonju Campus)
yunjlee@yonsei.ac.kr (Wonju Campus Medicine College)

We will send you the Certificate of Admission via e-mail.

1) 비자를 신청하실 분은 메일로 발송해드리는 표준입학허가서와 기타 필수 서류(예: 신청서, 여권, 연
세대학교 사업자등록증 등) 지참하여 대사관(영사관) 방문 및 비자 신청하시기 바랍니다. 

   With the Certificate of Admission and other required documents such as passport, 
application form, etc, please visit the nearest embassy in your country to apply for a D-2 
visa.

2) 한국에서 비자 연장 또는 변경 신청을 하실 분들은 서울남부출입국외국인사무소에 문의 후, 필요한 
제출서류와 함께 (예: 신청서) 여권, 표준입학허가서, 외국인등록증을 가지고 (예약 후) 방문하셔서 비
자 연장/변경 신청을 하시기 바랍니다. (http://www.hikorea.go.kr/pt/main_kr.pt 또는 대표번호 
1345) 

   If you want to extend or change your visa in Korea, please request it to the Southern 
Immigration Office (http://www.hikorea.go.kr/pt/main_kr.pt or just call 1345) about the 
detailed process or required documents. (eg. Application Form) We recommend you to visit 
the office after making a reservation. You will have to bring your passport, alien 
registration card, the Certificate of Admission, etc.
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※ 유의사항:　표준입학허가서를 수령하신 후, 반드시 허가서에 나와 있는 정보가 본인의 정보와 일치하는지 
            확인하시고, 틀린 부분이 있을 경우 재발급 요청을 해주시기 바랍니다.
※ Attention
  Please check whether all the information written on the certificate of admission is correct.  
  If there is any misinformation, please request for re-issuance.

주의: 2019 년 12 월 31 일 (화) 까지 신청을 하지 않으시는 분들은 표준입학허가서가 필요하지 않은 

것으로 간주하겠습니다. 

NB: If you don’t request for the Certificate of Admission by June 30 (Sun) 2019, we will 
take it as unnecessary for you.

입시원서를 제출할 때 일부 서류를 제출하신 것을 알고 있지만, 원활한 업무 진행을 위해 다시 한 번 
이메일로 제출 부탁드립니다. 

We are aware that you have already submitted some of the documents when you applied 
to our school, but please kindly send us the documents again via email for the 
progression of our work. 
Thanks in advance for your cooperation.

3) 담당자 연락처 Contact information

연세대학교 일반대학원 교학팀 서지수 
Jisoo Seo
Office of Academic Affairs, Yonsei Gradaute School
Tel) 82-2-2123-3233, Email) ysgrad@yonsei.ac.kr 

원주캠퍼스 교무처 교무부 안성혁
Seong-hyeok Ahn
Office of Academic Affairs, Wonju Campus
Tel) 82-33-760-2795, Email) acqwj@yonsei.ac.kr 

원주캠퍼스 의과대학 교학팀 이윤재
Medicine College, Wonju Campus
Tel) 82-33-741-0215, Email) yunjlee@yonsei.ac.kr
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   10. Alien Registration and Insurance Policy 
YONSEI UNIVERSITY GRADUATE SCHOOL  

□ Immigration Services 
Call center: Dial 1345
HiKorea website: http://www.hikorea.go.kr – E-application

1. Application for Alien Registration Card 
   A. Students must apply for an alien registration card at a local immigration office within 90 days 

of arrival in Korea
   B. Required Documents
      - Application Form (available at the immigration office), passport, 1 color photograph (3.5 x 

4.5cm)
      - Certificate of Admission
      - Fee 30,000 KRW
   C. Immigration Office: Check your local immigration office and make sure you have prepared all
                          the required documents before you visit the office. We advise you to make 
                          a reservation (www.hikorea.go.kr) for the visit. 

       * Seoul(Sinchon) Campus : Southern Immigration Office
         Address : 151 Mokdongdong-ro, Yangcheon-gu, Seoul 
         Tel : 02-2650-6212
          Walking distance 10 minutes from the Mokdong station (line 5) and Omokgyo station (line 5)

2. Requirement for Other Activities 
   A. International students with a D-2 (student) visa who wish to work part-time must acquire 

permission from the immigration office
   B. International students attending a graduate school are allowed to work a maximum of 30 

hours per week (Those of students whose TOPIK level is below 4 are only allowed half); a 
representative of graduate school office must confirm the related documents (application 
form/business licence) before submission so please visit the Graduate School Office (Stimson 
Hall 2F)

   C. International students who have changed work places must report of this change at the 
immigration office or via www.hikorea.go.kr

   D. Required Documents : Application form (available at the immigration office), passport, alien 
registration card, part time employment recommendation (applicable fees are waived for D-2 
(student) visa holders) 

3. Applying for an Extension of Length of Stay
   A. Application Period : From two months prior to the expiration date to the date of the 

expiration (Penalties are imposed when expiration dates are violated) 
   B. Required Documents : Application form (available at the immigration office), passport, alien 

registration card, application fee
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4. Reporting Change of Residence 
   A. Registered aliens must report a change of residence at a local immigration office within 14 

days of the moving
   B. Required Documents: Application form (can be picked up from the immigration office), 

passport, alien registration card, document to prove residence

5. Reporting Changes in the Alien Registration Card 
   A. All important changes (passport, name, gender, birth date, nationality) must be reported to a 

local immigration office within 14 days of the change
   B. Required Documents : Application form (can be picked up from the immigration office), 

passport, alien registration card, document to prove change 

6. Re-Entry 
   A. Registered foreigners who want to re-enter South Korea after staying overseas for more than 

a year within the granted period of residence in Korea must acquire a re-entry permit. 
(Exemption : Registered foreigners who seek to re-enter within one year of departure)

   B. Required Documents : Application form (can be picked up from the immigration office), 
passport, alien registration card

7. Taking a Leave of Absence : International students who seek to take a leave of absence from 
their current education program must apply for the leave of absence at their schools and must 
depart Korea within 15 days of reporting. Alien registration cards must be returned to an 
immigration official at the airport at the time of departure. 

H. Returning to School 
   1) Students who wish to return to school must apply for the reinstatement on the Yonsei Portal 

website during the specified application period.
   2) Students must submit required documents to the graduate school office to acquire a new D-2 

visa. (Students who are from the countries where it takes a long time to process visa 
applications are advised to submit all of the required documents to the school at least two 
months before returning.)

▣ Medical Insurance Policy 

1. Medical Insurance 
According to the regulations of the Korean Ministry of Education, all the international students 
(who do not hold a Korean citizenship) are required to maintain a medical insurance during their 
stay at Yonsei. International students are not allowed to register for the courses until they upload 
their Certificate of Insurance on Yonsei Portal. Please read the following guidelines carefully and 
upload your certificate before the deadline. 
※ KGSP students will be informed of this separately by email.   

2. Types of insurance (Choose one)
   1) Insurance Company affiliated with Yonsei University (Discount prices)
      - Company: Meritz Insurance 
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                   (Agency: Central Ins Korea http://n.foreignerdb.com/yonsei1) 
      - Insurance Fee: 102,000KRW (Male), 118,000KRW (Female) (for a year, TBC)
      □ Information for Newly admitted students

 Insurance coverage start date: February 2020 (TBC).
 If you arrive in Korea before the start date of insurance, we advise you to purchase an 

extra travel insurance covering the period.       

   2) National Health Insurance 
      - National Health Insurance Corporation: http://www.nhic.or.kr, Tel 1577-1000
      - Newly admitted students will not be able to apply for the NHI if they do not have an Alien 

Registration Number. So we recommend you to arrange other type of insurance first and 
then apply for the NHI later.

 
   3) Private Insurance from a company in your home country
      - It is allowed ONLY IF it covers your medical expenses while you are in Korea
      - The certificate must include your personal information, policy period, coverage, etc. 

3. Submission (Deadline: January 31, 2020) 
   1) Yonsei Portal (http://portal.yonsei.ac.kr,) Academic Information System → Academic 
Management System → Student Record → Information → Insurance (JPG format only) 
      * Please upload the Certificate of Insurance in JPG file format
      * For National Health Insurance, please upload 건강보험자격득실확인서

       

   2) If you have any trouble uploading your document on the portal, please contact the Graduate 
School Office at ysgrad@yonsei.ac.kr / 02-2123-3233.

4. How to Claim insurance payment(Agency: Central Ins Korea http://n.foreignerdb.com/yonsei1) 
   A. Using KAKAO for claim

 1) Login on the website using your student number or Alien registration number or
          Passport number and password.

 2) Click the menu “my information” and click “Download Claim report.” 
          Print it out and fill out all the information.

 3) Search and Add our KAKAO ID
          (Korean, English Service: INSCLAIM / Chinese Service: CLAIMS)

 4) Prepare all the necessary documents for claiming.(Please refer to 5. Necessary
          documents for claiming.) Scan or take a picture individually and send them via
          KAKAO. The Pictures must be accurate and clear.
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      5) If there is no problem with your document, you will get your payment within 
         minimum 3~5 days.(except weekend and holiday) The agency will contact you to 
         request additional document if any document is missing. 
   B. Using Website for claim
      1) Login on the website using your student number or Alien registration number or 
          Passport number and password.
      2) Click the menu “my information” and click “Download Claim report.”
          Print it out and fill out all the information.    
      3) Prepare all the necessary documents for claiming.(Please refer to 5. Necessary 
          documents for claiming.) Scan or take a picture individually and compress the
          file. Please upload it to “upload documents for claim.” 
      4) If there is no problem with your document, you will get your payment within 
         minimum 3~5 days.(except weekend and holiday) The agency will contact you to 
         request additional document if any document is missing.

5. Necessary documents for claiming(Agency: Central Ins Korea http://n.foreignerdb.com/yonsei1) 
   A. Common documents
      1) Claim report + Personal data processing agreement(Download on website)
      2) Copy of your Alien registration card
      3) Copy of your bank book
   B. Inpatient treatment(Including surgery)
      1) Confirmation of hospitalization and discharging
      2) Receipt of treatment(not credit card receipt)
      3) Detailed statement of medical expenses
      4) Confirmation of Surgery(In case of taking surgery)
   C. Outpatient treatment
     * In case of the treatment fee is under KRW 30,000:
      1) Receipt of treatment(not credit card receipt)
      2) Detailed statement of medical expenses
     * In case of the treatment fee is more than KRW 30,000:
      1) Receipt of treatment(not credit card receipt)
      2) Detailed statement of medical expenses
      3) At least one of the following documents
        Medical records/outpatient confirmation/medical chart/doctor’s opinion paper
    D. Prescription(medicine)

 1) Prescription
       2) Receipt of pharmacy(not credit card receipt)
 
NOTICE
※ In case of obstetrics and gynecology/ proctology / urology / dermatology, no matter how much
you paid, you must prepare Medical records or prescription which provide the name of disease.
(It must includes disease code or name)
※ In case of taking MRI or CT examination, you must prepare “MRI(CT) scan reading report.”

◆ Please refer to  http://n.foreignerdb.com/yonsei1 for more information.
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Yonsei University Graduate School

  50 Yonsei-ro, Seodaemun-gu, Seoul 03722, Korea 
Graduate School Office (Stimson Hall 2F)

Tel: Seoul Campus / International Campus : +82-2-2123-3228
            Fax : +82-2-2123-8652

Wonju Campus : +82-33-760-2795
Fax : +82-33-760-2566

Email : ysgrad@yonsei.ac.kr
Website : http://graduate.yonsei.ac.kr


